
 

 
 

 
NVivo 7: An Overview 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

This document is designed to provide you with a brief 
overview of the NVivo software. It will help you to 
understand how the software can support your research 
or project. Specifically, it offers guidance on concepts 
that will help you to handle your data. 
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Introduction 

This booklet is designed to provide you with a brief overview of the NVivo software. It will help you to 
understand how the software can support your research or project. Specifically, it offers guidance on 
concepts that will help you to handle your data. 

For additional resources on NVivo consult the Online Help, which can be accessed through the Help 
menu in the software.  There are two sections available: Using the Software provides step by step 
instructions on how to use the software, while Working With Your Data explains research and data 
handling concepts. Also, a guide to Getting Started with NVivo is provided with the NVivo software 
box, or it can be downloaded direct from the QSR website. It contains information about installing 
NVivo 7 and introduces the basic steps to get you started. 

The First Steps 

When you open NVivo, the Welcome screen appears.  From here you can choose to create a new 
project, open an existing one or access Help.  You create projects to hold data, observations, ideas 
and links between them in NVivo. Click New Project to create a new NVivo project to work with.   

When you create a new project or open an existing one, the Welcome screen closes and the 
Navigation window appears.  From here it is easy to navigate your way to all sections of your project 
through the buttons on the left hand side of the screen.  

Click: 

→ Sources to add, open, edit, and code project data 

→ Nodes to add concepts and categories and code data to them 

→ Sets to group together project items 

→ Queries to ask questions of your data 

→ Models to create models to demonstrate or explore your data 

→ Links to connect project items together 

→ Classifications to add attributes or relationship types 

→ Folders to access different folders in your project 

When you click on a folder, a list of the items stored there appears on the right hand screen, this is 
referred to as the List View (as shown on following page).  

When one of these items is opened, the contents are displayed on the bottom section of the right hand 
screen in what is referred to as the Detail View (as shown on following page).   
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Setting Up Your Project 

Organizing Your Data: Folders 

Folders can be created for sources, queries and models to help you store and manage your data (see 
below).  You can choose whether or not to create new folders.  They may be useful for instance if you 
are working with different types of documents, for example, interviews and focus groups. Creating 
folders for each will allow you to access and work with each data type easily. Once created, a folder 
can be opened by double clicking to show the subfolders or items it holds.  
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Finding Your Data: Find and Advanced Find 

The Find tool in NVivo allows you to access project items easily by name.  The Advanced Find also 
allows you to find project items based on their properties and specified criteria (such as items that 
have a relationship to, or are linked to, another project item). 

Undo 

To give you confidence to explore your data, NVivo allows you to Undo your last five actions. Access 
Undo through the Edit menu.  

Customizing the Workspace 

Depending on the data you are working with and how you prefer to work, you can customize NVivo to 
best suit your needs.  For instance, you can choose to hide both the toolbars and the Navigation 
Window to provide more space, or choose application options to help you work with large datasets if 
needed.  For an extensive listing of the options available see the online Help contained within the 
software. 

Sources 

Sources are the records of your data in your NVivo project, your interviews, field notes, observations, 
journals, references and so on.  There are three types of sources: Documents, Externals and Memos, 
all of which can be edited, coded, searched and linked once in your project.  You can either import 
existing sources, or create new ones and enter your data directly into NVivo. 

To open a source click on the Source button on the Navigation View (left hand pane) and select the 
appropriate folder.  If the folder has subfolders, these will also appear in the Navigation View.  If the 
folder contains sources, these will appear listed in the List View (as shown below). To see the 
contents of a source, double click on the source name in the List View. The source content appears in 
the bottom half of the Detail View (as shown below).  Multiple sources can be opened at once and 
navigated to through tabs.  
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Sources can be given both names and descriptions as you choose, and these can be changed 
through the Properties window.  To access Properties go to the File menu. 

Documents 

Documents are textual data.  Microsoft Word™ documents as well as plain and rich text files can be 
imported directly into NVivo. If your documents are Word files they can contain embedded pictures or 
tables.  To import a document, highlight the Documents folder, right mouse click on the List View, 
choose Import Documents from the menu.  To add a new document, repeat the process and choose 
Add Document from the menu.   

Externals 

Externals represent data that you can’t, or don’t want to, import directly into your project.  Used for 
data such as video files, audio files or web pages, externals hold text that can then be worked with in 
the same way as other documents.  They contain the link to a file and/or are formatted to make it easy 
to enter the relevant data.  To add an external, highlight the Externals folder, right mouse click on the 
List View, choose Add External from the menu.   

Memos 

Memos are used to capture your ideas and thoughts on your data.  Stored in a separate area they can 
be edited, coded, searched and linked as needed.  To add a memo, highlight the Memos folder, right 
mouse click on the List View, choose Add Memo from the menu.   

Editing as Analysis 

Analysis can start as soon as you have imported or created sources in your project.  Use different 
fonts, formats, sizes and colors to mark passages for review, to highlight everything on a topic or to 
identify your commentary. 

The First Steps 

A project in NVivo often starts with a journal or project summary documents.  Add a new document 
and write your thoughts about research design and topic in it.  Go to the Format menu to date entries.   

If you don’t have data records for your project, start with material on the topic from literature or web 
pages.  Import relevant sources or create externals to represent web pages, books and other data. 

 

 
 

 

 

Getting Help 

For further assistance, go to the online Help and explore the topics under Sources (in the ‘Using the Software’ 
section) and Gathering Your Sources (in the ‘Working With Your Data’ section). 
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Nodes 

Nodes in NVivo projects are the containers for categories and coding.  Nodes can represent concepts, 
processes, people, abstract ideas, places or any other categories in your project.   

Nodes can contain any amount of coding. When you code, you store references to source content at 
the node.  Nodes do not have to have coding in order to exist, they can simply hold ideas for 
exploration, linking or modeling. 

There are five different types of node: free nodes, tree nodes, cases, matrices and relationships.  
Each of these has its own folder which appears when you select the Nodes button in the Navigation 
View.   While you cannot create subfolders for these Nodes folders, both Tree Nodes and Cases can 
be organized into sub trees. 

Creating Nodes 

Nodes can be created ‘up’ from the data as meanings are discovered or ‘down’ from prior ideas and 
theories.  You create a node simply by placing it in the node system and naming it.  A description is 
optional.   Nodes can also be created automatically by autocoding your data (for further information 
see pages 10 to 12 on coding). 

Types of Nodes 

Use Free Nodes to store nodes that do not yet belong in a logical or conceptual relationship to other 
nodes. The free node area is often used as a holding area to capture nodes before you move them 
into the tree node area. 

Nodes may also be organized hierarchically into trees, like a library catalogue.  Use the Tree Nodes 
(see image below) to catalogue categories and subcategories for easy access. 
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Use Cases to store material about each case.  These can also be organized hierarchically. Cases can 
be created upfront and then coded to from relevant source data or on import of a source, depending 
on the data you are working with.  You can add characteristic values (for example, demographic data 
such as gender) to cases through assigning attributes (see pages 16 to 17 of this document).  

Use Relationships to represent connections between nodes and other nodes or project items. The 
types of relationship represented are created through Relationship Types accessed through the 
Classifications button (see pages 16 to 17 of this document). 

The matrices folder (see image below) stores the nodes created by running a matrix query.  Unlike 
results nodes, matrix nodes can be coded and uncoded as required (see pages 10 to 12 of this 
document for information on Queries and Results). 

 
 
 

 

 

Managing Your Nodes 

Nodes can be reorganized, combined, moved or deleted as your project changes and grows.  Node 
properties such as names and descriptions can be changed through the Project menu as your ideas 
develop. 

Nodes can be moved to other areas or within the same area through using cut, copy, paste and merge 
functions available through the Edit menu.  You can choose to copy a node in its entirety and paste it 
somewhere different or you can choose to merge the contents of one node with another.  To move a 
node, select it then choose the appropriate options from the Edit menu. 

Early in the project, tentative ideas may be stored in the Free Nodes area.  Later, the free nodes can 
be moved to a logical place in the Tree Node area, as higher level categories are discovered.  The 
developing tree structure shows how your ideas are building up, its logical organization making it easy 
to find your ideas and code effectively.   

Relationships are different types of nodes because they make statements about what you are seeing 
in your data.  You can code at the relationship the data you see as evidence of this statement at the 
relationship.   

If any node is moved to a different node area, the structure of the node is changed (that is, it becomes 
the same type of node as the areas it is being moved into) but the coding remains.  



 

 Page 10

The First Steps 

Start by creating nodes for obvious categories, things you know this project is about.  You do not need 
to manage nodes logically early in a project.  Use free nodes until categories become clear and then 
organize them into trees. 

Ask, what is a case for your study?  Are you studying individuals or institutions etc with characteristics 
you need to store?  To add such information about people or groups to your project, each person or 
group needs to have a case. 

Cases can be created and coded to in the same ways as other types of nodes (see page 9) or you 
can create them directly from your documents either on import or once they have been imported.  If for 
instance you have a number of one on one interviews and you would like to store the data from each 
person as a Case, go to your Documents folder, and select the relevant documents in the List View, 
right-click and choose ‘Create Cases’. 

 

 

 

Getting Help 

For further information in relation to nodes, go to the online Help and explore the topics under the different node 
areas in the ‘Using the Software’ section. For assistance on developing a node system that works for your project, 
go to the ‘Working With Your Data’ section in the online Help. 

 

Coding 

Coding is used by most researchers to bring together data and ideas.  Before software, coding may 
have been achieved by marking up transcripts in margins or copying and filing under relevant topics.  
NVivo does this by placing references to source content at nodes. 

Coding can become a major burden if it is slow or routine, or if it is not combined with ways of 
reviewing and reflecting.  NVivo is designed to support many ways of coding and integrate them with 
other ways of exploring your data. 

You can create nodes and code while you edit or transcribe a document in NVivo.  You can also 
visually code using the rich text features such as color, font, size and format of text to mark up your 
text.  This reformatted text will then appear in the same format if you code it to a node. 

Choose How You Code 

There are a number of ways to create nodes and code content to them.  Create nodes upfront through 
the Project menu or by right-clicking in the List View on the area where you want the node to go. 
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When coding a source (or node), if you find a new theme you can choose to create a new node either 
by: 

• Selecting a specific word(s) that represents the theme and create an In Vivo node 
• Selecting the passage(s) that you want to code and type the name of the new node in the coding 

bar and click code. 

To code text at an existing node, select the text and then: 

• Drag and drop the text to the node in the list, or  
• Choose the node(s) to code to through the coding menu.  

You can automatically code any or all of your sources by using the Autocode options available 
through the Code menu, or by using the Query tool. 

• The autocode options allow you to code using headings or paragraphs. In each process nodes are 
created for each heading or paragraph and the relevant text coded to the node. 

• The results of NVivo text search or coding queries can be saved as nodes if you wish (see pages 
13 to 14). 

Always remember that when you have created node(s) automatically, there may be content coded at 
the node that is not relevant or content that is relevant may not have been coded.  Make sure you go 
back to review the contents of nodes created by autocoding or query.   

Viewing Coding 

Coding stripes show you patterns in your coding (see image below).  Choose which nodes you want 
to see the coding for.  You can then open the node directly from the coding stripe if you wish.   You 
can also select to see only the Coding Density Stripe that shows all coding. Hover over each section 
of the stripe for a list of nodes coded at that passage. 

You can also choose to highlight coding for a particular node or node(s) – or for all nodes. 

These options for viewing coding are accessed through the View menu. 
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Revising and Refining Coding 

You can code from the Detail View of a source or a node.  Coding from the node to other nodes 
supports further reflection and exploration.  This is termed “coding on”. 

The coding that you see when you open a node is live. It shows the source text exactly as it appears 
at that moment.  You can jump from this coded content directly back to the source data to recode or 
edit, view the context of a coded segment, and optionally select some or all of that context to enhance 
your coding.   

The First Steps 

Depending on the method you are using, it is often best to start with broad brush coding. Start with 
free nodes representing broad categories and code text to them.  Code on from those nodes to create 
more nodes and maybe move them down into the tree node structure as you want to group nodes 
together. 
 

As you work with the nodes, if you see them as having logical connections, move them into ‘tree’ 
catalogs to express this. 

You can change the layout of the List and Detail Views to vertical (through the View menu) and/or 
move the coding bar to another location to help you when coding.   

 

 

 

Getting Help 

For further information in relation to coding, go to the online Help and explore the topics under Coding in the 
‘Using the Software’ section. For information on the purposes and uses of coding, go to the ‘Working With Your 
Data’ section in the online Help. 

 

 
Sets  

Sets provide a way of grouping sources and/or nodes together.  Whereas folders only contain items of 
one type, sets can have a combination of nodes and sources.  

An item can be added to as many sets as appropriate.   

One of the best ways to use sets is for focusing on a group of data items as you query your data.  
Once a set of the required project items has been created, a query can be run on just that set. 

Sets may be useful when working in a team to gather together the documents, memos and nodes that 
belong to a specific team member. 
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Making and Saving Queries  

The query tool in NVivo can be used to ask questions and test hunches you may have about your 
data.  Queries can investigate patterns and connections between words or phrases in your text, the 
text coded at nodes and information about cases, such as demographic data, stored as attributes (For 
more information on attributes see the section on Classifications, pages 16 to 17). 

Queries you might want to rerun at a later stage or in other datasets can be saved in the Queries 
folder.  To save a query, click Add to Project on the Query screen. 

Results can previewed or saved as a node or set.  If you choose to save your results you can choose 
to keep them as Results nodes (which cannot be changed), save the node as a new node or merge 
with existing nodes.  Because it saves the results of a query as a node, the Query tool is also a way to 
create nodes and do coding.  Thus the query tool allows you to build one query on another, as you 
build your understanding and seek further patterns. 

To create a query, select the Queries folder, then right click in the List View and choose ‘New Query’. 

Types of Queries 

There are four different types of query to choose from: text search, coding, matrix coding and 
compound, each useful for answering different sorts of questions. 

Text search queries allow you to search for one or a combination of words and/or phrases that occur 
in the text of your project items.  You can choose which items to query, whether you want to save the 
result and whether or not you would like the results returned in context.  Text search query works like 
web search engines and has many way of specifying exactly what you want to find.  Go to Help on text 
search to find these powerful options.  

Coding queries allow you to query either single nodes or combinations of your project items.  Through 
an advanced query, by selecting the appropriate nodes you can develop queries to ask simple or 
complex questions of your coding.  You can ask about logical relations between items using the AND 
and OR operators or about relative locations of items using the operators NEAR, PRECEDING and 
SURROUNDING. 

Matrix coding queries allow you create tables of nodes or text searches or attributes.  The results are 
displayed in a tabular format with the contents available from the table cells (see image below). Each 
cell is represented by a node which can be opened directly through the cell. 
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Compound queries allow you to combine the functionality of a text search with that of a coding query. 

When running any query you can specify in detail the scope of project items you want to query.    

The First Steps 

Use query from the start of your project.  Don’t wait to ask questions until you have read and coded 
your data.   

For example, if you have interview data: 

• Autocode by searching for an occurrence of a text string and saving the results (with the 
appropriate context) to a node. 

• Check that your interviews are covering the issues of interest by autocoding questions and issues, 
then doing a table coding query of questions by issues.  Click on any cell to see what discussion 
occurred. 

 

 
 
 

Getting Help 

Go to the online Help and explore the topics under Queries and Results in the ‘Using the Software’ section. For 
further information on using queries in your project, go to the ‘Working With Your Data’ section in the online Help. 

Models 

Models in NVivo can be used to display, explore and explain what is going on in your project or how 
you have conducted it.  Create a model to show the connections between the various items in your 
project: use it to demonstrate the theory you are developing, the issues in your team work, or how 
your data supports (or doesn’t!) your early impressions.  

Visual models are often the best way to start in a project, you can enter project items in a different 
format which often brings up new ideas or questions to explore as your research progresses. 

Creating Models 

To create a model, select the Models folder, then right-click in the List View and choose ‘New Model’.  
Right-click to add project items and shapes as required.  Link the model items to represent your data 
and ideas.  Use Groups to show or hide different stages of your research or different areas 
represented in the model.  
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Add associated items to the model as required to show the evolving structure of interpretation. See 
below for an example of a model created in NVivo. 

 
 

 

 

 

 

 

 

 

 

Using Models 

Models can be used at any stage of your project for visualization and review of understanding.  
Documents, nodes and attributes are live in the model: click on an item to inspect its properties or 
open it.  Use the model to explore theory, check or display progress. Models are particularly useful for 
seeing relationships and analyzing them. 

Use the live items to show the data behind the theory.  For example, at a conference presentation, 
show the words used by a respondent, or material coded at a node. 

Track the evolution of your models by saving copies of the model at each stage.  You can save them 
as static or dynamic models. 

The First Steps 

Use the modeler to draw your project design, detail first impressions or list things to do.  Sketch early 
hunches, alternative theories and hypotheses, store these and return to them later to compare and 
change aspects as your ideas change.  Use the modeler to plan your research team roles and review 
team processes. 

 

 

Getting Help 

Go to the online Help and explore the topics under Models in the ‘Using the Software’ section. For further 
information on modeling in your project, go to the ‘Working With Your Data’ section in the online Help. 
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Links 

The purpose of most qualitative research is to explore the connections between the data and ideas in 
a project.  In addition to the relationship nodes, NVivo allows you to represent these connections 
through a number of links both between items within the project and data outside the project. 

Linking between items, and part of items, is easy as most connections between items will be 
represented by See Also links.  See Also links can connect to more than one item and any number of 
links can be created within one project item.  They can be created between entire project items as well 
as to selected parts of items.   

The only items not linked by See Also links tend to be memos about a specific source or node.  These 
are connected through Memo links.  Each source or node is restricted to one Memo link.  Linked 
memos have icons in the source’s List View. 

To capture ideas and comments relevant to a specific section of text, Annotations can be created. 
These notes are linked to the required text and displayed at the bottom of the open source or node if 
needed. Annotations can optionally be searched with text search queries. 

All links can be viewed and accessed through the appropriate folders stored under Links or through 
the project items from which the links have been created. 

Links can also be created from within your project to data external to NVivo through the use of 
Externals.  These are created through Externals accessed through the relevant folder in the Sources 
area (see page 7). 

 

 

 

Getting Help 

Go to the online Help and explore the topics under Annotations and Memos and See Also Links in the ‘Using 
the Software’ section. For further information on using links in your project, go to the ‘Working With Your Data’ 
section in the online Help. 

 

Classif ications 

The Classifications area comprises two folders, one to store Attributes and the other for 
Relationship types. 

Attributes 

Attributes store information about the people, sites or other items which are relevant to your project.  
An attribute (like Gender) can have any number of values (male, female etc).  Attributes are assigned 
to Cases which are nodes coding all the data relevant to a particular individual, group or site.  (see 
page 6 on creating cases). 



 

 Page 17

Attributes can be used to query your data using the designated values. For example, you can ask 
what all the males under thirty years of age said about a particular topic if you have the attributes set 
up for gender and age, the attributes have been assigned to the relevant cases and you have a node 
for the topic in question.   

Creating Attributes and Values 

An attribute and its values can be created directly by you within your NVivo project (through the 
Attributes folder).  You can import a table from a spreadsheet or statistical package.  Attributes are 
created and values assigned to the appropriate cases when the table is imported and may be viewed 
by opening the casebook (see image below). 

Relationship Types 

Relationship types are created by you to represent different ways items are related.  These may be 
statements (like employs, loves, is married to) or more abstract relations between concepts (like 
causes, co-occurs with or impacts).   

Relationship types can be represented in one of three directions depending on which is most relevant.   

• One way (for example, poverty causes poor health)  
• Associative (for example, poverty occurs with poor health)  
• Symmetrical (for example, poverty and poor health affect each other)  

The First Steps 

Researchers usually start off their projects knowing that some things need to be recorded as particular 
attributes, for example gender, age etc and relationship types, for example employs.  These sorts of 
classifications can be created upfront.  As your research progresses and more questions come up and 
relationships appear, you can add more attributes and relationship types as required.  It is best to 
store only those attributes and relationship types that you know you will need and add others as your 
research progresses, rather than entering a large number upfront ‘just in case’.   You will find it easier 
to work with a project containing only the data you actually need. 

 
 

 

 

Getting Help 

Go to the online Help and explore the topics under Cases and Attributes and Relationships in the ‘Using the 
Software’ section. For further information on using these in your project, go to the ‘Working With Your Data’ 
section in the online Help. 
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